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Introduction
In this document, Software or Web Site Usability Testing with Morae, walk through how to use
TechSmith’s Morae to conduct a usability test for computer applications, web sites, or anything else that users
interact with on a computer.
This document is intended for people that are already familiar with the concept of usability testing.
If you’re new to usability testing, start with Usability Testing Basics which explains the basics of usability
testing, including information about how to figure out what to test, when to test, and how to test. Usability
Testing Basics is available on the Morae Resource CD and in the Morae Learning Center
(http://www.techsmith.com/learn/morae/default.asp).

Software or Web Site Usability Testing With Morae
Morae is the premier software for deeply understanding customer experiences…and sharing those insights
clearly and powerfully. From usability testing to focus groups and beyond, Morae helps you transform designs
and marketing to make things people love.
For a software or web site usability test, Morae records desktop activity on the user’s computer and camera
video of the user. Using TechSmith Corporation’s patented Rich Recording Technology, Morae Recorder
captures all system events, including mouse clicks, web page changes, onscreen text, and more.
We will walk you through completing a test with Morae with the following topics:
Set Up the Test
Record and Log Test Sessions
Analyze and Present Findings
How to Retrieve Your Key Measures from Morae
The document also contains the following appendices:
Appendix A: User Research Request
Appendix B: Test Protocol Document
Appendix C: Example Usability Test Report
Appendix D: Usability Test Checklist
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Software or Web Site Usability Testing
Considerations
This is the type of testing most people imagine when using the term ―usability test.‖ In it, participants conduct
real world activities on a working prototype or a real version of the software, and observers measure
efficiency, effectiveness, and satisfaction along with other usability measures.
During planning, consider carefully what systems (e.g., testing computer) will be used in the test. A computer
needs to be set up to look like a realistic system that mimics how users actually interact with the product.
Make sure your test machine behaves and looks familiar to participants – or be prepared to assist participants
if the study calls for something unfamiliar.
The product’s development team also needs to provide:
Working software or a functional prototype on which participants can complete tasks
Assistance with data (e.g. information from a test database, a media hosting account containing preuploaded media, or a fake credit card number for making online purchases):
A method to reset the software to its original state and save the user’s work when appropriate

Procedure
The test may be conducted in your lab (which can be as simple as a room with a computer and Web cam) or
remotely using UserVue. Morae or UserVue records the screen, RRT data (such as mouse clicks and web
page changes), and any notes or markers logged by Observers, and Morae can capture the participant’s face
with a Web cam via Picture-in-Picture mode. Use the default configuration provided for software or Web
usability testing in Morae to record the test.
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Set Up the Test
After you figure out what to test and the goals for testing, use the steps in this section to set up the test in
Morae Recorder.

To set up a test in Recorder:
1. Create a Study Configuration
2. Define the Scenario
3. Define Tasks
4. Define Markers
5. Define Surveys
6. Save Study Details
7. Configure Recording Details
8. Complete Test Set Up
This document walks through this process at a high level. You can find more information on the full
procedures and options in the help included in the Morae components or find both video and written
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.
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1. Create a Study Configuration
A study is a group of test sessions where participants complete the same tasks. In Morae, a study
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and
surveys.
You use the same study configuration to record each of the test sessions. Only recordings with the same
study configuration can be later analyzed together in Morae Manager.
Morae Recorder includes template study configurations to help you define study configurations for different
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured
Recording Details which define how to record the session.
When you open Recorder, create a new study configuration based on Software or Web Usability Study.
When you click OK, the template study configuration opens in Recorder.

2. Define the Scenario
A scenario gives the participant the background to complete the tasks. It tells them why they are doing the
tasks and any introductory information they may need to complete the task.
The scenario should be realistic and allow the participant to relate to the situation. For more on how to create
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning
Center.
For example, to find out how users interact with your company web site, the scenario may be:
You will perform up to 4 different tasks using a web site.
You have just purchased a copy of SnagIt and you’re interested in learning more about the company
that makes it, TechSmith. Follow the instructions for each task and then perform the task as you
would if you were actually doing this task for yourself.
Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations,
and reactions.
Do you have any questions?
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Scenario in Morae Configuration
Recorder > Modify Study Details button > Description tab
Enter the scenario into the Study instructions field.

Morae Scenario Tips
Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test
Protocol Document).
To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See
AutoPilot in the Morae Recorder help for more information.
For more information, in the Morae Recorder Help, see Define Study Details > Define the Study
Description > Study Instructions.
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3. Define Tasks
The tasks should relate to real-life actions that fit the scenario. For more on how to create tasks, see
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center..
For example, if we use the example scenario of ―You have just purchased a copy of SnagIt and you’re
interested in learning more about the company that makes it, TechSmith,‖ our first task is to find the
TechSmith web site.

Tasks in Morae Configuration
Recorder > Modify Study Details button > Task Definitions tab
For each task, enter a name, description, and instructions for the participant.

Morae Task Tips
Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test
Protocol Document) on the Task pages. Each task should be on a separate page so the participant can
only see one task at a time.
To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen
to the participant. See AutoPilot in the Morae Recorder help for more information.
For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks.
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4. Define Markers
After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure
out what kinds of actions you want to define marker for because, by flagging important points during recording,
you can save time when you later analyze the results.
For example, mark:
Participant actions
Participant comments and questions
Participant frustration
Areas where a participant gets stuck
Application or web site design issues
Observations about how the participant performs a task
Interesting comments or actions to include in a highlight video
Moments when participant’s access Help, want to contact customer service or technical support
You can also add notes to provide additional details for each marker. All the markers and notes are
synchronized with the video and saved in the recording of each test session.
Morae also includes the ability to score markers, for example, you can use the score to log serverity of errors,
from 0 (severe) to 2( minor). Manager can automatically calculate the average severity of the errors.

Markers in Morae Configuration
Recorder > Modify Study Details button > Marker Definitions tab
In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and
color. Each study configuration template includes a default set of markers. The Software or Web Usability
Study template includes the following markers:
Q – Quote/comment

X - Error

H – User needs help

O- Observation

P - Participant prompted

V – Video clip

Use the provided default markers, modify the markers, or create new markers that match the goals of your
study or identify specific things you want observers to watch for during a session.

Morae Marker Tips
There is no correct number of markers. The object of logging markers during a test is to make it easier to
analyze the test results.
If you have specific things you want to look for in a test, create a marker for that action, problem, etc.
Later when you analyze your sessions in Manager, markers help you sift through data and focus on what
you want to analyze. For example, viewing all the Help requested markers may reveal an error where
people are really struggling.
When you are ready to create video clips or a presentation for stakeholders, you save time by quickly
going to the moments during the session that you marked to include in the highlight video.
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For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers.

5. Define Surveys
With surveys, you can collect information directly from the participants. After you import recordings into
Manager, you can view and compare responses, create graphs based on the surveys, and export results,
including any freeform answers.
Morae can deliver multiple surveys to participants during a session. For example, surveys can be delivered
before the test, after each task, and after the test.
The template study configuration includes surveys. Use or edit the surveys provided or create your own
surveys.

Surveys in Morae Configuration
Recorder > Modify Study Details button > Survey Definitions tab
Create and associate surveys with session events, such as the end of a task.
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Morae Survey Tips
Associate a survey with the beginning of recording, end of recording, or the end of each task.
By associating a survey with a session event, it is ―linked‖ to that event.
AutoPilot automatically displays surveys when the associated session event occurs.
Observer readies the survey associated with the current session event.
Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test
Protocol Document).
The System Usability Scale (SUS) is freely available for use in usability assessment and has been used
for a variety of research projects; the only prerequisite for its use is that any published report must
acknowledge the source of the measure. If you use the SUS, add the following to your report:
―SUS was developed as part of the usability engineering program in integrated office systems
development at Digital Equipment Co Ltd., Reading, United Kingdom.‖
For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys.

6. Save Study Details
File > Save Study Configuration or click the Save Configuration icon.
Study Details must be the same for all recordings in a study and include the items you have just defined:
 Study name, description, and instructions
 Tasks definitions and instructions
 Marker definitions and instructions
 Survey definitions and associations
By saving the study configuration, and reusing that configuration, all recordings in a study have the same
configuration and can be imported into the same study in Manager.

7. Configure Recording Details
Recording Details included in Morae study configurations define how to record the session, including the
following:
File saving and processing options
Video sources
What data to capture
Who logs tasks
How to start and end test recordings
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Recording Details in Morae Configuration
Recorder > Recording Details button
The Recording Details of the template study configuration allow you to immediately conduct a recording.
The Recording Details for the Software or Web Usability Study template include:
Prompt for file saving details when recording stops
Record the primary monitor and include a camera Picture-in-Picture (PiP) video
Capture all available system data, including mouse clicks, keystrokes, and screen text
Assign the first Observer connected to Recorder as the Task Logger
Start and stop recordings manually with Recorder

Morae Recording Details Tips
Recorder automatically chooses the source camera for the PiP video. Verify the selected source is correct
before recording.
If you change any Recording Details settings, the rest of the settings update to provide a valid or
recommended configuration, if needed.
Recording Details are saved as part of the study configuration. While the Study Details must be the same
for all recordings in a study, the Recording Details can vary in each recording.
To get the most out of Morae recordings, record all available data, including mouse clicks, keystrokes,
and screen text. If you are not allowed to capture some of this data, click Capture Options and change
the Data settings.
For more information, in the Morae Recorder Help, see Define Recording Details.

8. Complete Test Set Up
Study configuration is now complete. Here are the final things to do before you start testing.
Create Test Protocol
Finalize Morae Recorder Setup

Create Test Protocol
The test protocol is a document of everything needed for a test. There is an example protocol document in
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.
Test Session Setup Checklist
Release Form
Facilitator Script
Participant Instructions and Surveys
Assemble Participant Paperwork (Optional)
Email Invitations for Observers
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Test Session Setup Checklist
Verify the computer setup is the same at the beginning of each test. A test setup checklist makes it easier to
go from one test to the next as quickly as possible and make sure you do not miss anything.
Make a list of all the things you need to do between tests and include it in test protocol document, such as:
Close the software program.
Clear the internet browser history, cookies, cache, etc.
Log out of an application.
Prepare participant forms (release form, surveys, etc.)

Release Form
A release form gives permission to record the test. Morae records the participant’s interactions on the
computer along with video and audio of the participant.
Some participants may only allow you to record the screen activity and session audio. In the case that
the participant does not want the camera video captured, choose not to include PiP in Recorder >
Recording Details button > Capture Options.
If the contents of your test require the participant to keep session and web site/product information
confidential, include a non-disclosure agreement with your form.
The example test protocol includes a sample release form that includes a non-disclosure agreement.

Facilitator Script
The facilitator script helps to explain the test session to the participant. The facilitator reads through the script
at the beginning of each test session to ensure the participant understands what to expect during the test.

Participant Instructions and Surveys
Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the
study configuration in the add-in and drag the study and task instructions along with the surveys into the
protocol.

For more information, click the help button in the Morae Add-In for Word.
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Assemble Participant Paperwork (Optional)
Once you finish the protocol document, you need to assemble any paperwork needed for the test.
If you would like to cut down on the amount of paper needed for a test, you can use AutoPilot to
automatically present surveys, study instructions, and tasks right on the computer running Recorder. To
find out more about AutoPilot, in the Morae Recorder Help, see Autopilot.
If you are printing paperwork, each participant needs a copy of the following:
Release form
Background questionnaire
Scenario/session instructions
Tasks
For the facilitator, print out a copy of the entire protocol. In addition to the participant items listed above,
include the following:
Title page
Session setup checklist
Participant paperwork coversheet
Facilitator script
Task success paths (the best way or ways to complete a task)
List of debrief questions (follow up questions for the end of the test)
See the example test protocol in Appendix B: Test Protocol Document for an example of a complete
protocol.

Email Invitations for Observers
Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people
that observe the test can connect to the session, send an email to each observer with the following
information:
Name of test
Date of test
Time of test
IP address or name of Recorder computer
You may also want to include a list of the test tasks and markers to let the observers understand what
they should watch for during the test.
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Finalize Morae Recorder Setup
Prior to a Morae test, complete the following tasks:
Complete the Pre-recording Checklist
Run a Pilot Test before Recording

Complete the Pre-recording Checklist
The following checklist describes critical points that reduce the technical issues you may encounter and
improve Morae’s overall performance.
Step

Description

Verify the system
requirements

Verify your system meets the recommended specifications to get the most
efficient performance from Morae. For more information, see Morae System
Requirements in the Morae Recorder Help.

Verify you have
enough hard drive
space

Recording file sizes may be approximately 10–15 MB per minute, but the actual
size varies depending on many factors. You should have extra space available for
the best performance during recording.
As a general rule, maintain 5–10 GB of extra hard drive space as a buffer beyond
what your Morae recording files use.
We recommend initially saving your recordings to a local hard drive to
eliminate the chance of data loss that can occur when saving over a network
or to an external device. After the file is saved, you can copy the recording file
to an external device.

Test your setup and
scenario

Test your setup before the actual recording session to resolve any possible
complications (such as firewalls blocking Observer(s) from connecting, etc.).
We recommend running a pilot recording for a short period of time to test
Recorder’s start and stop options and to verify Observer(s) can connect. For more
information, see Run a Pilot Test before Recording.
In addition, use the Test Recording option in Recorderto create a 15 second
recording to verify the screen, camera, and audio streams are being recorded
properly.

Verify Network
Settings

If Observer and Recorder are on the same Intranet, you do not need to disable
firewalls.
If they are not, verify that you either disabled any firewalls running on the Recorder
or configured the firewalls to open the communication ports. See your network
administrator for assistance.
There are no firewall adjustments necessary on the Observer side.

Disable desktop
wallpaper

Remove the background wallpaper on the desktop and use a solid color as the
background to improve compression when you record the desktop.

Open the study
configuration in
Recorder

Open the saved study configuration in Recorder.

Run a Pilot Test before Recording
We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot
recording helps you work out any network connectivity issues and test your automated start and stop options,
if applicable.
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Follow these steps to run a pilot test:
Step

Description

1. Open your saved study
configuration

In Recorder, open the study configuration (.mrcfg) for this study.

2. Start Recorder

Click the Start button to start Recorder manually.

3. Connect Observers to
Recorder

Connect one or more Observers during the pilot test. Verify that you
can successfully connect each to Recorder.

4. Complete a test task

Run through one of the tasks. To test the logging functionality of
Observer, have a team member practice setting markers while you
complete the task.

5. Stop Recorder

Either stop Recorder manually by clicking the Stop button in Recorder
or use the keyboard shortcut <Ctrl + Alt + Shift + F9>.

6. Import the recording and run
a search

Save the test recording file and import it into a project in Manager. In
Manager, verify the screen video, audio, and camera video recorded
correctly. Use the Search to verify the other RRT data streams have
been captured accurately. See Analyze and Present Findings for
more information on how to do this.
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Record and Log Test Sessions
In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae
Recorder and Observer. Included in the section are the following:
Observers and Logging
Start and Stop the Recording
Log the Sessions
Send Surveys
Save the Recording

Observers and Logging
Morae Observer connects to Recorder over a network and displays the full participant’s experience, including
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores,
and text notes that are sent back to the Recorder and saved with the recording file.

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically
create graphs, calculate marker scores, and more.
Observers can connect prior to the beginning of a recording, as long as Recorder is running. Observers do
not see the participant interaction until recording begins.
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Observer Benefits
Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the
following benefits:
Stakeholders can connect to watch live sessions without the need be in the room with the participant or in
an observation room. With Observer, stakeholders can connect from anywhere on the network.
Anyone logged into an Observer computer can add markers during recording complete with text notes.
Morae automatically collects and compiles everyone’s notes. The recordings contain the markers and
notes logged by all Observers.
Observer automatically saves and indexes the markers and tasks with the accompanying video and audio
streams.
You can save a copy of the camera video, screen video, and audio streams as a WMV file for immediate
playback or to share with stakeholders.
For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to
Recorder.

Start and Stop the Recording
The default way to start and stop recordings is to manually start and stop Recorder using the following
buttons:

Start

Stop

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your
equipment and participant set up.
For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start
Settings and Define Recording Details > Recording Stop Settings..

Log the Sessions
Once recording starts, the facilitator prompts the participant to begin the test.
Each person using Observer can log markers, marker scores, and add text notes that are sent back to the
Recorder and saved with the recording file. One Observer designated as the task logger logs tasks and task
scores. You can save a copy of the recording as a WMV file for immediate viewing. You can also save a copy
of your markers and notes.
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The components used when logging in Observer are:

Quick Tips for Logging a Session
There are several different ways to log markers and tasks. To find the one that works best for you, in the
Morae Observer Help, see Log a Session > Markers > Different Ways to Log a Marker.
Tasks only appear in the Log if you are the task logger.
During recording, you can go back and edit previously logged markers and tasks.
The markers and tasks defined in the study configuration are available to log.
Log marker and task scores to use in Manager during analysis. For example, if you log marker scores,
you can create a graph that automatically calculates error severity rate.
While you can add markers, tasks, and scores in Manager after importing the recording, you will save
time by logging tasks and markers during a session.
You can save a copy of the Log after each session as a .txt file to print or open in other applications (i.e.
Microsoft Excel).
If you need immediate access to the recording, from Observer, you can save a copy of the recording as a
WMV.
For more information, in Morae Observer Help, see Log a Session.
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Send Surveys
Deliver the surveys to participants during the recording anytime during the session.
Automatically – Run the sessions with AutoPilot to automatically deliver surveys.
Manually – All Observers can access and deliver surveys. If you manually deliver the survey during the
session, Morae records the participant filling out the survey.
In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>.
In Observer, select and send surveys in the log.

Save the Recording
By default, when recording stops, you are prompted for file details. Enter a name and description for the
recording. If you want to start another recording right away, in Recording Details, choose to defer the
processing of the recording. You can later batch process recordings.
For additional options, in the Morae Recorder Help, see Define Recording Details > File Details >
Processing.
You cannot save a recording without a name. You can lose the data from a recording if the test
participant, or anyone else, closes the dialog prompting for these details after the recording stops.
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Analyze and Present Findings
In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and
create presentation materials for the test findings.

Included in the section are the following:
1. Import Recordings
2. Edit Recordings
3. Analyze Recordings
4. Graph
5. Create Highlight Clips
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6. Create a Report

1. Import Recordings
To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the
recordings and studies in Manager.
You can have multiple studies in a single project. The following are possible reasons to have multiple studies
in a single Morae project:
You conduct the same test on different iterations of a product.
You conduct various tests on the same product.
You want to separate your studies by the experience level of participants.
You can import a single recording into multiple projects. When you import a recording into a project, the
original recording is not touched. A copy of the recording imported into the project. Any changes you make to
this copy do not affect the original recording.
You can import Morae recordings (.rdg), UserVue recordings (.rdg) and standard video files (.avi, .wmv, .asf)
into a project.
For more information on importing recordings and creating projects, in the Morae Manager Help, see Create
and Modify a Project > Create a New Project.

2. Edit Recordings
View and edit the imported recordings in the Analyze Tab. In Manager:
Review screen video automatically synchronized with user video and audio.
Create additional or edit the logged tasks, markers, notes, and scores.
Search across recordings in a study for specific event types or text that appeared onscreen (i.e., find
every time the users clicked on a specific web page).
View and edit survey answers.
For information, in the Morae Manager Help, see Analyze.

3. Analyze Recordings
Morae recording (.rdg) files are unique because they are composed of multiple, rich data streams collected by
TechSmith’s patented Rich Recording Technology (RRT).
For more information on what kinds of things to look for in the recordings, see How to Retrieve Your Key
Measures from Morae.
Manager’s Search allows you to quickly create custom searches to look for web page changes, window/dialog
events, mouse clicks, keystrokes, screen text, markers, and tasks.
You can use the pre-defined search profiles, define a new search, or create and save your own search
profiles.
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For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings.
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4. Graph Data, Tasks, Markers, and Surveys
Instead of manually calculating data and building graphs, Morae creates graphs to help you share results
faster, without manual calculations and scrubbing of data.
Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight
videos. Highlight videos can be more powerful with graphs included to support the video clips.
Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format
(CIF) standard – effectiveness, efficiency, and satisfaction:
Measure effectiveness with error rate and completion rate graphs
Measure efficiency with a time on task graph
Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to
participants at the end of the recording

Example Uses of Graphs
Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why
you might want to use these graphs.
SUS Survey
Graph

Use this graph to measure satisfaction from a
System Usability Scale (SUS) survey.
SUS scores can range from 0 (very little
satisfaction) to 100 (very high satisfaction).

Survey
Analysis

SUS Survey
Calculation

Time on Task
Graph

Use this graph to measure efficiency.
Efficiency is usually measured by determining how
quickly participants are able to complete scenarios
or tasks.
Participants may be able to successfully complete
an activity, but they take a long time.
Task Analysis

Time on Task

Mouse Clicks
Graph

Use this graph to measure the number of clicks
required to complete a process.
Add a constant line to show optimal clicks. For
example, if the goal is for participants to find
information on a web site in three clicks or less,
you can easily see if that goal has been met.
Input Device
Analysis

Mouse Clicks

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph >
Graph Analysis Examples.

Page 25

5. Create Highlight Clips
When you are ready to organize the results of your analysis into a highlight video for presentation, select
Manager’s Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort video clips, title clips,
and graphs and assemble them into a video presentation.
In the Present tab, assemble the important video clips, graphs, and tasks into a highlight video to share with
stakeholders. Include just the participant’s screen and audio in the highlight video or add a Picture-in-Picture
(PiP) window showing the participant’s facial expressions. The highlight video can be produced in AVI, WMV,
or MPEG-4 format.
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After you have your highlight clips together in the storyboard, click the Produce Highlight Video button and
select the Produce to PowerPoint option to produce the videos and send them into a PowerPoint
presentation.

For more information on creating highlight clips and options for exporting other data from Manager, in the
Morae Manager Help, see Present.
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6. Create a Report
Appendix C is an example report showing where you can place graphs, data tables, and other information
generated by Morae.
Use the Morae Add-In for Word to put items created in Manager, including graphs, graph tables, tasks, and
surveys into the report. Open the project file in the add-in and drag the items into the document.

For more information on how to use the Morae Add-In for Word, click the help button in the Morae Add-In for
Word.
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How to Retrieve Your Key Measures
from Morae
Name

What was Measured

How To Retrieve the Measure in Morae

Time on Task

The length of time it takes the participant
to complete a task.
May be averaged for all participants and
can be compared between tests.

If this has not already been completed,
set the start and end markers at the
beginning and end of each task and
create a task on the Morae Manager
timeline.
When all tasks are created, choose the
Time on Task Graph in the Graph tab to
see the results. Results may be
averaged or viewed by task or by
participant.

Task Success

Whether or not the participant was
successful and to what degree: completed
with ease, completed with difficulty, failed
to complete.

Select each task’s properties and set the
participant’s success score for each task.
View the results on the Graph tab,
Success Score.

Learnability

A task is repeated at least once to
determine whether the time on task is
shorter, fewer errors are made, or the
task is more successful.

Note each participant’s performance on the
same or very similar tasks.
On the Graph tab, choose Time on Task, Errors
and/or Task Success and limit your results to
the tasks that are similar.
Look for trends such as lower time on task,
fewer mistakes and greater success.

Satisfaction

Enumerates participants’ overall feelings
about a product before, during, and/or
after a test.

Initial impression surveys, task exit surveys, the
Satisfaction Usability Scale Survey (SUS) make
be included with each configuration, and
administered before the test, after each task or
following the entire test.
Set these up in your configuration before the
test.

Mouse Clicks

Measures the number of clicks that a
participant enters.

View the results on the graph tab by choosing
Input Device Analysis.
Part of the Rich Recording Technology™ data
already captured in your recording.

Mouse
Movement

Measures the distance the mouse travels.

View the results on the graph tab by choosing
Input Device Analysis.
Part of the Rich Recording Technology™ data
already captured in your recording.

Problem/
Issue Counts

Records, counts, ranks, and/or
categorizes problems observed.

Set up one or more markers to note problems in
your recording configuration. You may wish to
include a severity scale. Ask observers to make
note when a problem is observed.
To view result, search for those markers on the
Analysis tab. Export them to spreadsheet for
use with findings.
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Name

What was Measured

How To Retrieve the Measure in Morae

Optimal Path

Observes the path a participant takes to
accomplish a task and compares it to a
predefined optimal path.

Make a recording of someone taking the
―optimal path‖ as one of your ―participants.‖
On the Analysis tab, view Windows/Dialog
Events or Web Page Changes for each
recording, ordered by participant. Compare
each test participant to the optimal. Look for
trends and common places where participants
wandered ―off the path.‖

Make Your
Own

With Rich Recording Technology ™ data,
you can design the study that fits your
needs

Search for events, create markers or analyze
the data you need. Customized Graphs can be
created to meet your specification.
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Appendix A: User Research Request
Collect the following information to use as the base of a usability test.
Item

Description

Examples

Background

Introduce the product and
give background on why you
want to gather user
feedback.

The product team is looking to gain insight into how users
interact with the company web site. We’d like to learn
more about user’s expectations for the site and how they
find what they’ve looking for, i.e. search engine, web site
search, browsing, etc.
When originally creating the company web site, it was
meant to contain mainly contact information and product
documentation. Now that we’ve moved on to provide
additional resources, downloads, tutorial videos, and
more, we’re not sure that the format of the site is
appropriate.

Participants

Desired qualities of
participants.

We’d prefer participants with no or little experience with
the TechSmith web site, but they should be comfortable
using the internet.

Usability
Goals

What you hope to learn with
this test.

Before we redesign our web site, we’d like to learn more
about how our users interact with the currently available
materials. By learning about our users, we will be able to
make informed design decisions.

Key Points

What kinds of actions or
features the test tasks should
cover.
Also may include a list of the
questions the team wants the
usability test to answer.

The tasks should cover working with the web site in a
couple of different ways. The tasks should help answer
the following questions:
Can users easily find the web site?
Can users find a specific item on the site?
Can users successfully download an accessory for a
product?
Can the users find and use the blog?

Timeline

The timeline for testing:
When the product will be
ready for testing
When the team would
like to discuss the results
Any other constraints.

The web site is available for testing at the current time.
The team would like the results back to us by the end of
this quarter, as we will start design next quarter.

Additional
Information

Anything else that needs to
be taken into consideration.

The whole product team will be out for a conference from
February 1 through February 5. Since we would like
everyone to observe each test, please do not schedule
testing for these dates.

Page 31

Appendix B: Example Protocol

(Name of Project)
Protocol
Facilitator Script, Data-Collection Sheets, and Participant Forms
For (Product), ABC Corporation

[Version 1|Date]
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(Product Project)Protocol
This document is the observation protocol for the (Name of Project), which ABC Corporation will conduct with
up to 10 participants throughout Southeast and Mid-Michigan. This document contains all the materials
needed for the observation sessions, including the session set-up checklist, the facilitator’s script, datacollection sheets, and participant forms.

Session Set-Up Checklist
Before a session begins, the usability team performs all set-up tasks for the session as follows:
Computer



Start computer
Set up camera
Open Morae Recorder
Check camera angle
Do test recording
Verify sound and video in test recording
Clear cache or data in program
Participant Paperwork
Release and Non-disclosure agreement
Background Questionnaire
Session Instructions and tasks
Additional Points
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Facilitator Tips
Usability testing is conducted in a way that solicits the user’s thinking and feelings without interfering with his
or her own discovery process. No judgment should be apparent to the user about the user’s activities, and no
direct help is usually offered.
If the user appears stumped, a prompt such as ―Do you see anything on this screen that will help you?‖ may
be asked, but normally, the user will not be told exactly how to succeed, unless that has been scripted into
the protocol for a specific purpose. Failure is an appropriate outcome for some tasks. A debrief on thoughts,
problems points, and observations from the test are usually conducted.
Observers logging for the test administrator will want to capture start and stop times, significant statements,
errors and problems, and other noteworthy events. Accuracy is not critical – but timeliness can be. Capturing
as many observations as appropriate is preferable to perfect grammar while logging.
User observation is usually conducted in a free form. Chat with participants until they forget they are being
recorded.
Questions should generally be limited and open-ended questions such as ―I noticed that you have a post-it
note to remind you of XXXX. Can you tell me why? Can you tell me about a time when you needed to
remember this item but had trouble?‖ Diplomacy and tact are absolute requirements.
Observers want to make sure those activities, comments, and surroundings are captured. Tasks may be
timed from start to finish. This would be especially helpful for repetitive tasks, but any process that might take
time would be worth capturing. Try to be unobtrusive as they work, even at the expense of capturing data.
Notes can be taken later – this is qualitative data, not quantitative.
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Introduction/Facilitator Script
The purpose of the Introduction is to help participants feel comfortable with the observation process in general
and to explain their role in helping to improve the usability of (the Product) in particular.
Start Time: _____________________
Begin the session by saying:
Thank you, [name], for agreeing to participate in this user study. My name is [name], and I’ll be working with
you today. In this study, we’re exploring how people who use our products like to work. We’d like to talk with
you and watch you perform the tasks that you perform in the course of your work every day. We may ask you
some questions while you work.
I will try to be as unnoticed as I can sometimes, and at other times, I might ask
you about what you are doing, to help me understand your work patterns better.

Administer Questionnaire and Non-disclosure
Okay, let’s talk about how we would like to work with you this session. I’d like to position myself here, and
record your activity on the computer. I may also make the notations in my notebook as well.
I’m going to give you this series of (number) tasks to perform, with a scenario to explain why you are doing
these tasks. As you work, feel free to perform whatever tasks you think are appropriate, whether they are
related to our products, to computers, or not. I can try to provide anything you might feel is missing. What I’d
like you to do, though, is to talk out loud about the things that you are thinking, doing, feeling and expecting.
You are free to ask me any questions. However, depending on the type of study we are doing, I may or may
not answer you, or I may answer with another question.
Please feel free to talk about anything you encounter, especially any problems you have during the tasks. I
am not the developer of these products —I’m part of an objective evaluation team—so you can feel free to
give me your candid opinions. You won’t hurt anyone’s feelings. Your comments are important, which is why
we’ll be taking notes and videotaping the session, which also gives us a record of what you’re looking at. I’d
like to remind you at this time that your name will not be used in our report, and that all information you
provide today will be reported anonymously.
I want you to know that you are free to stop or take a break at any time, and that will not affect the
consideration we will be providing. Please let me know if you need anything to make yourself more
comfortable.
Do you have any questions for me?
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Participant Paperwork
This page is a cover sheet for all session data pertaining to this participant. Store each participant’s session
data in his or her own folder or envelope and labels each page of notes and forms with the participant’s
number.

Participant #: ______________________
Session: ___________________ (date/time)

Pre-session Paperwork
Before testing begins, the participant fills out the following forms:
Understanding Your Participation (Video release/authorization)
Permits recording the session. If permission is denied, you may still conduct the session and use the
participant’s data in reporting results. If it includes a non-disclosure agreement, the participant is required
to keep session and web site/product information confidential.
Background Questionnaire (to verify screened-for participant characteristics and to provide a
background and usage context in which to interpret t data)
Once setup is complete and all forms are filled out, the facilitator begins with the introduction.
The facilitator will hand the forms on the following pages to the participant at the appropriate times during the
test session.
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Understanding Your Participation
Please read this page carefully.
ABC Corporation is asking you to participate in a (Type of Study) study. By participating in this evaluation,
you help us improve our products.
We will observe you and record information about how you work. We may record your comments and actions
using written records, recorders and video cameras.
By signing this form, you give your permission for ABC Corporation to use:
recorded voice
verbal statements
session recording

(if you consent to this, initial here _____ )
(if you consent to this, initial here _____ )
(if you consent to this, initial here _____ )

This data will be used solely for the purposes of product design and development. Your full name will not be
used during any presentation of the results of this study.
Any information you acquire about our products is confidential and proprietary and is being disclosed to you
only so you may participate. By signing this form, you agree not to talk about this product to anyone. You may
tell them that you helped to evaluate an Internet web site.
You may withdraw from the evaluation at any time. If, at any time, you need a break, please inform the
observer immediately. If you have questions, you may ask at any time.
If you agree with these terms, please indicate your agreement by signing below.
Name (Printed)
Address
Signature
Date
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Background Survey Page 1
Please take a few minutes to answer the following questions to help us better understand your use of
computers and the Internet. No information from this survey will be linked to you in any way.
Participant: ______________________________________________________

Computer Use
1. What type of computer do you use?
At home:
PC Mac
At work:
PC Mac
2. About how many hours a week do you use a computer?
At home: ___________________
At work: ____________________
3. What do you typically use your computer for?
Games and pleasure
Graphics
Accounting/Finance
Data storage (i.e., databases)
Email or chat
Internet
Word Processing
Other ___________________________

Internet Use
1. How long have you been using the Internet? _____________________________
2. Which Internet browser or browsers do you use?
Browser

# Years Used

Internet Explorer
Mozilla Firefox
Other:
Other:
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# Months Used

Background Survey Page 2
Participant: ______________________________________________________
3. How would you rate your experience and proficiency using the Internet?
Poor
Average
Excellent
1
2
3
4
5
4. What do you usually do on the Internet
 surfing
 selling
 email

 site development

 chat

 interactive games

 information gathering

 MP3 downloading

 buying

 Other

5. Have you ever made any online purchases?
 No
 Yes

How often?

What have you purchased?

What problems, if any, do you encounter most often when purchasing online?

6. How often do you use the (Product)?
 Never
 Once or twice
 Once a year
 Once a month
 At least once a week

(Study Name)
Usability Study
Participant ID:

Test Date/time:
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Caution
This is the administrator's version of the usability test. This version includes the success path for
each task. Not to be given to the user before the usability session.
(Remove this information and the success paths prior to giving the test to a participant.)

Test Scenario/Session Instructions
You will be performing up to ___different tasks using ____________.
<<Provide needed information about the scenario: role, location, etc.>>
Instructions for each task are given in the shaded text boxes.
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Task 1.
Task 1 instructions here.
Tip: Ask an easy question for early success.

Task 1 Success Path.
Provide an answer for the facilitator version only. Remove from the participant version.
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Task 2.
Task 2 instructions here.

Task 2 Success Path.
Provide an answer for the facilitator version only. Remove from the participant version.
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Task 3.
Task 1 instructions here.
Tip: Ask an easy question for early success.

Task 3 Success Path.
Provide an answer for the facilitator version only. Remove from the participant version.
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Thank you for participating in the study!
Debrief Topics
List topics here that will be relevant to understanding, including problems, errors, events and quotes. In an
A/B test, show the alternative and solicit feedback, if appropriate. Ask nonjudgmental, open ended questions,
such as, “I noticed that you did x? Can you tell me about what you might have expected?”
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Appendix C: Example Report

[Product Name]
[Company Name]
[Usability Study
Type]
Date
User Experience Project Contributors
UX Team Member
[Name]

Role
[e.g., Project Manager, Lead, Facilitator, Observer, Designer,
Analyzer, etc.]
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Contents
Insert table of contents
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Executive Summary
Summarize points of report here:
Name and describe the product
Summary of method(s) including number and type of participants and tasks
Results expressed as mean scores or other suitable measures of central tendency
Reason for and nature of the test

Summary of Performance Results
User #

Measure 1

Participant 1
Participant 2
…
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Measure 2

Methodology
Objectives (Or Research Goals)
[This evaluation was designed to answer the following questions:
List usability questions here
…
More stuff on research goals…]

Product
[Information on product; version; if pre-release which build; if prototype then details on mode of prototype
(low-fi/paper, wireframe; hi-fi/flash); if web product then similar information including URLS; etc.]

Participant Profile
[How participants were recruited. Compensation/considerations offered.
Total number of participants. User types (e.g. experienced and inexperienced) and number of, etc.
Participant information, e.g. profession, interest or motivation for product use, and information from
demographic/background questionnaire.
Include links to (in network drives or locations in this document as appendices) background questionnaire,
tables of results from questionnaire, and participant screener or recruitment communication materials, if
necessary. ]
Characteristic 1

Characteristic 2

…

Characteristic N

Participant 1
Participant 2
…
Participant N

Research Design
Timeline
[Information on when the tests took place.]
Research Component

Dates

Recruiting

[Date] – [Date]

Test planning and design

[Date] – [Date]

Conducting research

[Date] – [Date]
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Analysis

[Date] – [Date]

Results Presentation

[Date] – [Date]

Research Environment
Where tested.
Information on lab, remote, or off-site area, equipment, event (if applicable), recording methods used, etc.

Test Design
[Information on type and length of test (e.g. ―One-on-one sessions lasted an hour for each participant, and
included:‖
Informed consent form for participation – Participants were asked to sign a consent form before they
participated.
Background questionnaire – We administered a brief questionnaire to gather background information on
participant work, technology, and product experience.
Verbal overview of study – Participants were given a description of the general nature of the study and
advised on how best to perform during the test.
Research performance – Participants were asked to perform several tasks using the product. The tasks were
in the context of doing x activity to provide a realistic context for testing. Participants were asked to think
aloud and describe any confusion while performing tasks. This was used to identify areas of difficulty, as well
as usage patterns and types of participant errors.
Post-study debriefing -- Participants were debriefed at the end of the session on certain areas of their
performance or to give further feedback.
Post-study questionnaire – A post-study questionnaire was administered to obtain satisfaction ratings.
Include links to (in network drives or locations in this document as appendices) to test protocol document (and
prototype files, if applicable).]
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Results
Constraints
Information about constraints.

Metrics
[Key usability goals included effectiveness, which refers to how well a system does what it is supposed to do;
efficiency, or the way a system supports users in carrying out their tasks; and satisfaction, which relates to the
subjective responses users have to the system.
Effectiveness is typically exhibited by task success, efficiency by time on task, and satisfaction is typically
measured with a scale.
The quantitative measures included:
Time on task
Error rate
Success score (or task success)
The qualitative measures included:
participant satisfaction ratings (post-study questionnaire)
verbal feedback during and after the session]

Time on Task
Insert graphs and table of data.

Error Rate
Insert graphs and table of data.

Success Score
Insert graphs and table of data.

Satisfaction Ratings
Insert graphs and table of data.
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Usability Issues and Recommendations
Usability Issue

Recommendation
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Severity

Conclusion and Next Steps
[Information/recommendations to team on how to proceed with recommendations and suggestions on further
research/design work to be done.]
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Appendix
[Put Possible Appendices to Related Docs Here]
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Appendix D: Usability Test Checklist
The purpose of this checklist is to identify the activities required for planning and executing a successful
usability test.

1. Meet with Stakeholders to Conduct an Initial
Interview
 Review the system to be tested
 Document concerns and define problem statements
 Determine acceptable usability goals and purpose
Use these to determine your ―Key Evaluation Measures‖
 Review user profiles or types of users
 Determine a preliminary test date
 Document:
o Intent of the test
o Overall methodology planned
o Business objectives and goals
o Usability goals
o Users and user groups to be tested

2. Recruit Participants





Document the number of participants in each user group to be tested
Develop a testing schedule based on preferred times and dates
Develop a screener to vet participant qualifications according to user group
Use any resources to contact users:
o Internal or customer databases
o E-mail contacts
o Newsletter, product, or web site posts
o Professional recruiting agencies
o News, web site, or social-networking service ads
 Schedule participants
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3. Plan the Test
 Design test scenario and task list
 Determine key evaluation measures
 Create a usability test protocol containing:
o Anticipated machine set up (lab, off-site, etc.)
o Checklist for setting up and facilitating each test session
o Introduction script
o Non-disclosure and recording agreements
o Background questionnaire
o Tasks (including success criteria, participant test booklets, etc., if needed)
o Debrief questions
o Post-task or post-test satisfaction surveys, if needed
 Schedule any facilities or space required for lab setup, observation, or participant debrief/greeting
 Load the necessary software and data needed to conduct the test
 Confirm test dates and time with participants, including location, maps or directions, and contact
information
 Create a folder for each participant containing all participant paperwork included in the test protocol
 Prepare ―thank you‖ notes and considerations for participants
 Invite executives, managers, development team members, marketing staff, and other stakeholders to
observe the tests

4. Run-through the Test





Install final software and/or prototypes and configure the test machine
Review test objectives, metric measures, and areas of concern with observers
Run a pilot usability test, including recording
Revise test materials as needed based on pilot test
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5. Conduct the Test















Power up lab machine, check cameras and microphones
Send connection information (e.g. IP address) for using Morae Observer to stakeholders and observers
Check availability of refreshments for participants
Greet your participant at test site as scheduled
Ensure participant comfort (e.g., temperature, seating, etc.)
Have the participant fill out the non-disclosure/recording agreement and any background questionnaires
(if not using Morae to deliver surveys and questionnaires)
Start the Morae recording
Review the test procedure with the participant (using the Introduction script)
Use best practices for facilitation
Debrief participant after test (including post-test questionnaire and any questions)
End Morae recording
Thank the participant, give any considerations for participation, and walk participant out
Reset your test or lab machine, clear data, and save participant activity as appropriate following each test
session
Collect all test materials, save recording file, review with observers as time permits, and store notes and
materials in folder; debrief with stakeholders and observers periodically
Repeat these steps for each participant test session

6. Analyze the Test






Using Morae Manager, review your test and conduct analysis on key evaluation measures
Make highlights video clips of interesting moments
Document findings and recommendations (collaborate with development and stakeholders)
Create a presentation or report
Present findings and highlights tape to stakeholders

7. Next Steps
 Send thank you notes and considerations to participants (if not already done)
 Determine ―lessons learned‖ and communicate to peer group
 Finalize project portfolios, organize and/or archive recordings, and store materials for later reference
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